Thesis preparation using Word 2010
Have you opened a word document and started madly typing? Then STOP. You may be surprised to know that what you think happens first should actually happen last, and vice versa! This A-Z of preparing your thesis document guarantees reduced stress when the deadline looms for handing in your thesis.

**In this workshop you will:**
- identify potential problem areas in preparing your thesis document

**Discuss:**
- how to lay out your thesis in accordance with University and discipline-specific instructions
- using styles simply and effectively as well as section breaks, headers and footers
- the importance of referencing correctly in accordance with discipline-specific styles

**Learn:**
- how to prepare your thesis as a professional document for examination, without any of the last minute panic of having to reformat it or chase up missing references
THE FIRST COMES LAST AND THE LAST COMES FIRST
Confused?

The first

1. What is the first thing you do when you begin writing your thesis?
   - Do you just open a word document on your computer and start typing everything in?
     Tempting, isn’t it!
   - But what about the page layout? Does it conform with thesis layout specifications? (check specifications for your discipline)?
   - What are the page default settings on your computer? Have you checked?
   - BEFORE YOU START ENTERING TEXT, make sure you SET UP YOUR DOCUMENT CORRECTLY.

2. Think about the CONTENT LAYOUT of your final masterpiece.
   - Where is the table of contents?
   - At the beginning?
   - But, this is the very last thing you add to your final product.

The last

Where is the bibliography/reference list?

At the end?

But, when writing your thesis, you need to make sure that THE FIRST THING YOU DO WHEN YOU READ AN ARTICLE/BOOK etc. is to WRITE DOWN CORRECTLY THE FULL REFERENCE AND PAGE NUMBERS of anything you have read or might quote, plus the full quote, OR IMPORT IT INTO AN ENDO NOTE LIBRARY. Also, be sure to put quote marks around direct quotes, and clearly label paraphrasing in your notes. Stick to the referencing style designated by your School/discipline – keep a copy of this with you at all times. If adding to an Endnote library, ensure again that you put in all information CORRECTLY.

Referencing in full as you go will prevent problems later on when you are in a panic to get everything finished and suddenly cannot find a reference you need, bits of your references are missing or you cannot remember which bits are direct quotes, or which bits are paraphrased or your own comments re a reference.

Step by step document preparation

Stick to the standard layout as below, plus any School-specific guidelines you have been given.

Standard PAGE LAYOUT:
   - Left margin 2 cm
   - Right margin 2 cm
   - Top margin 2 cm
   - Bottom margin 2 cm

   If you are printing your Thesis for binding the Left margin is 4.5cm
   - Paper size A4*** It is important to ensure you set your printer to A4 also, as some default to letter size, which will totally change what your document looks like when it is printed. When printing, ensure that the ‘allow A4/Letter paper resizing’ option is not ticked, and that ‘no scaling’ is selected. In the ‘paper’ menu for print options, ensure you select A4.
How to set your page layout

Layout for single sided printing

**Page Layout**

1. On the main menu (either at the top, bottom or side of the screen) click on Page Layout

2. Click on arrow on right hand side at bottom of shaded area labelled ‘Page Setup’: full page set up menu appears
   a. click on margins
   b. set top margin to 2cm
   c. set bottom margin to 2cm
   d. set left margin to 2cm
   **If you are printing your Thesis for publication the left margin is 4.5cm**
   e. set right margin to 2cm
   f. set ‘gutter’ to 0cm, and leave ‘gutter position’ set on ‘left’. (The gutter setting is for double sided printing, as in books. It provides extra white space when opening up a double page of a book, to avoid text being swallowed in the central area where the pages go into the book’s binding. As theses are printed on one side of the paper only, there is no need for any gutter setting. However, if you are instructed to print on both sides of the paper, then you would need to set the gutter to about 0.5cm. Position remains set on ‘left’).
   g. Under ‘orientation’, select ‘portrait’. *** Inserting ‘Landscape’ = lengthwise pages is explained later***
   h. Under ‘Pages’, ‘multiple pages’ select ‘normal’
   i. Under ‘Preview’, ‘apply to’, select ‘whole document’. *If you are working on a file that has more than one section, select ‘this section’ here. If you have just opened a document to begin setting your template, ‘whole document’ is the only choice available here.

3. Next, click on ‘Paper’
   a. under ‘Paper size’, select ‘A4’
   b. under ‘Paper source’, select ‘default tray’ for both ‘first page’ and ‘other pages’
   c. under ‘Preview’, ‘apply to’, select ‘whole document’. *see note for 2i above; the same applies here
   d. click on ‘Print options’, then under ‘printing options’ select ‘print drawings created in word’, ‘print background colours and images’ and ‘update fields’
   e. Click OK.
4. Next, click on ‘Layout’
   a. under ‘Section start’, select ‘new page’
   b. under ‘Headers and footers’, leave check boxes blank; different odd and even relates to inserting running headers or footers (eg chapter number and short title) and page numbers for double sided printing; different first page is used if you do not want to insert a running header or footer on the first page of each section (chapter)
   c. next go to ‘from edge’, set header to 1.27cm (0.5 inches) and set footer to 1.27cm (0.5 inches)
   d. under ‘Vertical alignment’, select ‘Top’
   e. under ‘Apply to’, select ‘whole document’ (*As with margin settings, if you are working on a file that has more than one section, select ‘this section’ here. If you have just opened a document to begin setting your template, ‘whole document’ is the only choice available).
   f. you do not need to set ‘line numbers’ or ‘borders’, as you will not need these
   g. Click OK

   (***Note: Line numbers are useful if you have transcripts, as it makes it easy to refer to excerpts in your document. To add line numbers to a document, click on ‘line numbers’, tick line numbering, then select the option you want – continuous throughout each transcript is generally the most useful option).
Now that you have the correct ‘page setup’, write down the page setup specifications in case you forget them. Once you have finished setting up your layout and styles in one document, you can save this document as a template to use for all chapters. We will do this at the end of this workshop.

1. Set up one file that contains the Title page; one file that contains all ‘Preliminaries’, which includes Table of Contents, Summary, Declaration, Acknowledgements (in this order); one file for each chapter; one file for Appendices; and one file for References/ Bibliography (if using Endnote references will appear at the end of each chapter, and then at the end of the final document after all files are put together).
2. Insert a ‘Section break’ at the end of each file. This is important, as it controls page numbering, page layout and what appears in the headers and/or footers.

To insert a section break, place the cursor at the end of your text, then:
   a. on the main menu, click on ‘Page layout’
   b. click on ‘Breaks’
   c. under ‘section breaks’, select ‘Next page’. The section break will be put in
    **If you select odd page or even page, you will get blank pages between sections

3. If you need a landscape layout for pages within a chapter/file, for example to accommodate a large table or diagram, use section breaks to ‘section’ these pages off from the rest of the chapter. Follow the same steps as in 2a-c, then ensure you hit enter several times to give you workable space on the page. Then insert a second section break
   ***To change the layout:
   a. Click on ‘Page layout’ on the main menu
   b. Click on the triangle beneath orientation
   c. Click on landscape (the margins already set for your portrait pages should remain but will be converted to landscape)

Isolating a different section with section breaks allows you to format each section differently and prevents formatting in the rest of the document from changing.
WORKING IN HEADERS AND FOOTERS

Page numbers

1. Insert ‘Page number’
   a. on the main menu click ‘Insert’
   b. click on ‘Page number’

2. Click on Bottom of page and select Plain

3. This will take you into the Design menu

4. Look along the bottom menu bar in Design until you see ‘Navigation’

5. In Navigation look for ‘link to previous’ - if it is highlighted this means it is switched on

6. If switched on, click on link to previous to turn it off

7. Click on page number in this menu and select ‘Format page numbers’

8. Select the number format you want (choose small Roman numerals for preliminary sections of the thesis; for main part of thesis select normal/Arabic numerals)

9. If you want page numbers to continue from the previous section/chapter, check ‘continue from previous section’

10. If you want to start fresh numbering in the section or chapter, select ‘start at’ and enter the starting number (usually 1).

***Sections in the ‘Preliminaries’ file will have small Roman numerals for page numbering, while the rest of the document will have Arabic numerals. This is one of the reasons why it is important to keep the ‘same as previous’ option turned off. If it is on, all numbers or text in the header or footer will be the same throughout the entire document - so will all text in headers or footers (you might get 400 pages with a footer saying Chapter 1)***

***When working in headers and footers, you must have the cursor blinking in the header or footer space on the page, otherwise nothing will happen. When you click into the header or footer space, the Design menu will appear, which includes the header and footer sub-menu.***
TEXT LAYOUT – USING STYLES

The easiest way to set your text layout is by using ‘styles’. It is important to set your styles for a consistent appearance. This is particularly important in the case of ‘normal’ style, the ‘default’ style that pops up when you begin typing in any word document. ‘Normal’ default may differ from computer to computer, so you may need to modify it to meet thesis specifications.

Heading styles also enable you to create an automatic table of contents and lists of tables, figures, diagrams etc. While it takes time initially to set your styles for your thesis, it saves time in the long term. You can set your own styles for things such as block quotes, bulleted lists, transcript excerpts, table of contents etc. If you are happy with the heading styles inbuilt in your computer, and they meet the thesis specifications, you can use these but will still need to set up a document as a styles template to ensure consistency in all files.

A quick way to set a consistent set of major (headings) and body text (main text) styles is to use the change styles menu.

FONTS

Fonts required for a Thesis are to be Sans-Serif type. These are fonts without curls or flicks. A lot of fonts will display in different sizes based on the font selected. The most common fonts and recommended sizes are:

- Arial - minimum 11
- Calibri - minimum 12
- Tahoma - minimum 11
- Verdana - minimum 11

The remainder of the document is based on Arial as the font.

Changing whole document styles

1. On the main menu click on ‘Home’ then on ‘Change styles’

2. Click on ‘Style set’ then ‘Default (Black and white)’

3. Go back to ‘Style set’, click on ‘fonts’ then select ‘Office Classic 2’
How to set your text layout

1. Find out what line spacing is required for your thesis – 1.5 or double line spacing? This is important for setting your thesis ‘normal’ style.

2. On the main menu click on ‘Home’

3. Then click on the down arrow at the right hand bottom corner of the ‘Styles’ sub-menu. This opens the styles window.

4. Scroll down to ‘Options’ and click; this brings up the Style Pane Options menu.

   a. select ‘All styles’ and ‘Alphabetical’ for how the list is sorted
   b. Check ‘New documents based on this template’
   c. Click OK

5. Scroll up ‘Styles’ until you see ‘Normal’, then right click on it

   a. Left click on ‘modify’
   b. in ‘Style for following paragraph’, select ‘Normal’

---

Flinders University - Centre for Educational ICT
6. Format the modified style ‘Normal’ - Click on ‘Format’
   a. Click on ‘Font’; this brings up the font menu
   b. under ‘Font’ select ‘Arial’.
   c. under ‘Font style’ select ‘Regular’
   d. under ‘Size’ select 11
   e. under ‘Font color’ select automatic
   f. under ‘Underline style’ select ‘(none)’
   g. under ‘Effects’, ensure no boxes are checked
   h. now click on the ‘Advanced tab’
      i. set ‘Character spacing’ to 100%
      j. set both ‘spacing’ and ‘position’ to ‘normal’
      k. ensure ‘kerning’ is not checked
      l. check ‘snap to grid when defined’
      m. other features leave as ‘default’

   Click ‘OK’. This takes you back to the ‘Modify Style’ menu

7. Click on ‘Format’, then ‘Paragraph’
   a. select ‘Indents and Spacing’
   b. under ‘Alignment’, select ‘Left’ (***or ‘Justified’ if this is specified in your instructions***)
   c. under ‘Indentation’, select 0 for both left and right
   d. check ‘automatically adjust right indent when defined’
   e. under ‘Spacing’ select 0 for ‘Before’ and 12 for ‘After’
   f. under ‘Line spacing’ select 0.63cm/0.25” under ‘By’
   g. ‘Outline level’ – make sure it is set on ‘body text’
   h. Make sure ‘Don’t add space between paragraphs of the same kind’ is NOT CHECKED
   i. Check ‘snap to grid when defined’
   j. now click on the ‘Line and page breaks’ tab
   l. under ‘Pagination’, ensure no boxes are checked
   m. Under formatting exceptions, check ‘don’t hyphenate’
   n. Click on ‘Tabs’
      o. in tab stop position, type 0.63 cm
      p. under alignments, select ‘left’
      q. under ‘Leader’, select ‘none’
   r. click ‘OK’ to go back to the ‘Modify Style’ menu
8. Click on ‘Format’, then ‘Border’
   a. select ‘Borders’, then click the ‘none’ box
   b. select ‘Shading’, then click ‘no colour’ under ‘Fill’, and ‘Clear’ under ‘Patterns’
   c. Click OK. This takes you back to the ‘Modify Style’ menu

9. Click on ‘Format’, then ‘Language’
   a. select the language you need
   b. ensure there is no tick in the ‘do not check spelling and grammar’ box
   c. click ‘OK’. This takes you back to the ‘Modify Style’ menu

10. Click on ‘Format’, then ‘Frame’
    a. ensure that ‘Text wrapping’ is set on ‘none’.
    b. click ‘Remove frame’
    c. click ‘OK’. This takes you back to the ‘Modify Style’ menu
11. Click on ‘Format’, then ‘Numbering’
   a. ensure that ‘Numbering’ and ‘Bullets’ are set on ‘none’.
   b. click ‘OK’. This takes you back to the ‘Modify Style’ menu.

12. Create a shortcut key for your new ‘Normal’ style
   a. Click on ‘Format’, then ‘Shortcut key’
   b. Under categories select ‘Styles’
   c. Under commands, select the style you want to create the shortcut for
   d. Under ‘specify keyboard sequence’, in press new shortcut key type in X7 for example. If this already a shortcut for something else, it will show up in current keys. You will need to select a different sequence.
   e. Click ‘Close’. This takes you back to the ‘Modify style’ menu.

13.  
   a. Click on ‘Format’ then ‘Text effects’
   b. Select ‘solid fill’ for first item – leave all others on ‘no’ or ‘none’

14.  
   a. Finalise style by checking ‘Add to quick style list’ and ‘New documents based on this template’ in the ‘Modify Style’ main menu.
   b. Click ‘OK’.

Now you have the style set for the bulk of your text. Make sure you write down the formatting details of your modified ‘normal’ style just in case of computer malfunction or other loss of your thesis template.

**HEADING STYLES**

Try not to have any more than three heading levels throughout your text. Designate chapter headings as Heading 1, then in-text heading levels as Heading 2, Heading 3, Heading 4. You can create a Table/Figure/Diagram Heading style, or simply use the ‘caption’ heading installed in your computer. The visual effect of each Heading style should represent its level. Some sample heading styles are set out below.

**HEADING 1 – CHAPTER HEADING**

**Heading 2 – major in-text heading**

**Heading 3 – in text sub-heading 1**

**Heading 4 – in-text sub-heading 2**

**Table heading/Figure heading/Diagram heading**
HEADING 1

Follow the same process as for setting your thesis ‘normal’ style, but begin by selecting Heading 1:

1. Scroll up ‘Styles’ until you see ‘Heading 1’.
2. Right click on this.
3. Click on ‘modify’ - this brings up the modify style menu

   a. in ‘Style based on’, this will default to Normal
   b. in ‘style for following paragraph’, select ‘Normal’ (i.e. your body text style)
   c. Check ‘Add to quick style list’ and ‘New documents based on this template’

4. Click on ‘Format’, select ‘Font’
   a. under ‘Font’ select ‘Arial’
   b. under ‘Font style’ select ‘Bold’
   c. under ‘Size’ select 16
   d. under ‘Font color’ select automatic
   e. under ‘Underline style’ select ‘(none)’
   f. check ‘All caps’
   g. Click on ‘character spacing’ - follow same steps as for ‘Normal’ style set up
5. Click on ‘Format’, then ‘Paragraph’  
   a. select ‘Indents and Spacing’  
   b. under ‘Alignment’, select ‘Centred’  
   c. under ‘Indentation’, select 0 for both left and right  
   d. check ‘automatically adjust right indent when defined’  
   e. under ‘Spacing’ select 0 for ‘Before’ and 24 for ‘After’  
   f. under ‘Line spacing’ select single  
   g. under ‘Special’ select ‘(none)’  
   h. ‘Outline level’ – make sure this is set at Level 1  
   i. Tick ‘Don’t add space between paragraphs of the same style’  
   j. Tick ‘snap to grid when defined’  
   k. now click on the ‘Line and page breaks’ tab  
   l. under ‘Pagination’, ensure no boxes are checked, but check the ‘no hyphenation box’  
      (same process as for body text style)  
   m. click ‘OK’. This takes you back to the ‘Modify Style’ menu  

Now follow the same steps for setting Tabs, Border, Language, Frame, Numbering, Shortcut key and Text effects as for setting the ‘Normal’ text style.  

6. Make sure ‘Add to quick style list’ and ‘New documents based on this template’ are checked in main ‘Modify style’ menu  
7. Click ‘OK’  
8. Make sure you write the details of your ‘Heading 1’ style with those for your ‘Normal’ style.  

**Heading 2**  

Follow the same process as for Heading 1, but begin by clicking on Heading 2 in the Styles list, then ‘modify style’ with the following variations:  
1. Click on ‘Format’, select ‘Font’  
   a. under ‘Font’ select ‘Arial’  
   b. under ‘Font style’ select ‘Bold’  
   c. under ‘Size’ select 14  
   d. under ‘Font color’ select automatic  
   e. under ‘Underline style’ select ‘(none)’  
   f. under ‘Effects’, ensure no boxes are checked  

All other steps in the ‘Font’ menu are the same as for Heading 1  

2. Click on ‘Format’, then ‘Paragraph’  
   a. select ‘Indents and Spacing’  
   b. under ‘Alignment’, select ‘Left’  
   c. under ‘Indentation’, select 0 for both left and right  
   d. check ‘automatically adjust right indent when defined’  
   e. under ‘Spacing’ select 15 for ‘Before’ and 12 for ‘After’  
   f. under ‘Line spacing’ select single  
   g. check ‘snap to grid when defined’  
   h. select ‘Line and page breaks’ from the menu  
   i. place a tick in ‘widow/orphan control’, ‘keep lines together’ and ‘keep with next’ (this will prevent a level 2 heading from standing alone at the bottom of a page)  

All other steps in the ‘Paragraph’ menu are the same as for Heading 1, except ‘Outline level’ is set at 2.  

4. Make sure ‘Add to quick style list’ and ‘New documents based on this template’ are checked in main ‘Modify style’ menu.
5. Click ‘OK’
6. Make sure you write the details of your ‘Heading 2’ with details of your other styles.

**Heading 3**

Follow the same process as for Heading 2, but begin by clicking on Heading 3 in the Styles list, then ‘modify style’:

1. Click on ‘Format’, select ‘Font’
   a. under ‘Font’ select ‘Arial’
   b. under ‘Font style’ select ‘Bold’
   c. under ‘Size’ select 12
   d. under ‘Font color’ select automatic
   e. under ‘Underline style’ select ‘(none)’
   f. under ‘Effects’, ensure no boxes are checked

All other steps in the ‘Font’ menu are the same as for Heading 2

2. Click on ‘Format’, then ‘Paragraph’
   a. select ‘Indents and Spacing’
   b. under ‘Alignment’, select ‘Left’
   c. under ‘Indentation’, select 0 for both left and right
   d. check ‘automatically adjust right indent when defined’
   e. under ‘Spacing’ select 12 for ‘Before’ and 9 for ‘After’
   f. under ‘Line spacing’ select single

All other steps in the ‘Paragraph’ menu are the same as for Heading 2, except ‘Outline level’ is set at 3.

4. Make sure ‘Add to quick style list’ and ‘New documents based on this template’ are checked in main ‘Modify style’ menu
5. Click ‘OK’

**Heading 4**

Follow the same process as for Heading 3, but begin by clicking on Heading 4 in the Styles list, then ‘modify style’:

1. Click on ‘Format’, select ‘Font’
   a. under ‘Font’ select ‘Arial’
   b. under ‘Font style’ select ‘Italics’
   c. under ‘Size’ select 12
   d. under ‘Font color’ select automatic
   e. under ‘Underline style’ select ‘(none)’
   f. under ‘Emphasis mark’, select none
   g. under ‘Effects’, ensure no boxes are checked

All other steps in the ‘Font’ menu are the same as for Heading 3

2. Click on ‘Format’, then ‘Paragraph’
   a. select ‘Indents and Spacing’
   b. under ‘Alignment’, select ‘Left’
   c. under ‘Indentation’, select 0 for both left and right
   d. check ‘automatically adjust right indent when defined’
   e. under ‘Spacing’ select 9 for ‘Before’ and 6 for ‘After’
   f. under ‘Line spacing’ select single

All other steps in the ‘Paragraph’ menu are the same as for Heading 3, except ‘Outline level’ is set at 4.

4. Make sure ‘Add to quick style list’ and ‘New documents based on this template’ are checked in main ‘Modify style’ menu
5. Click ‘OK’
6. Write the details of your ‘Heading 4’ style with details of your other styles.

***These instructions are for non-numbered headings.

USING NUMBERED HEADINGS

The easiest way to use Numbered headings in your thesis is to work with the built-in heading styles. You can then automatically number these.
1. Click Heading 1
2. On the ‘Home’ menu, go to the ‘Paragraph’ sub-menu.
3. Click on the multilevel list icon
Select the list style you want for your headings
TABLE/FIGURE/DIAGRAM HEADING STYLES

You can use the ‘insert caption’ menu to insert the required table or figure or diagram caption into your text.

1. Click on ‘References’ tab on the main menu
   a. Go to ‘Captions’ sub-menu
   b. Click on ‘Insert caption’

   ![Insert Caption Menu]

   c. Select ‘Label’ – choose what label you want, ie Figure, Table etc. If the label you need is not there, select ‘New label’, type in your label and click ‘OK’

   d. If you are using numbered headings, select ‘Numbering’. IF YOU ARE NOT USING a numbering system for your headings throughout the thesis (ie 1, 1.1, 1.2 etc), make sure ‘include chapter number’ IS NOT CHECKED. Select your preferred number format from the format list.

   e. Click ‘OK’. This takes you back to the ‘Caption’ menu. Click ‘OK’ again.

   ![Caption Dialogue Box]

   ![Caption Numbering]

   IF YOU ARE USING the numbered heading system for your headings throughout the thesis (ie 1, 1.1, 1.2 etc), make sure ‘include chapter number’ IS CHECKED. Select ‘Chapter starts with Heading 1’, then select the type of ‘separator’ you want, eg Figure 1-1, or 1:1 etc.

   You can modify the ‘caption’ style so that it is similar to Heading 3 in appearance, but one font size smaller (font size 11). It may already be set as this, or it may be one size smaller again (size 10). If you are happy with the default setting for ‘caption’, just use it as it is. ***Caption may not appear in the ‘all styles’ list unless you actually insert a caption. It is then possible to modify the style.

   If you wish to modify the way the caption style looks, follow the same procedure as for setting up other heading styles, but begin with ‘Caption’ in the Styles list, then select ‘Modify’. Make sure you write the details of your thesis caption style with those for your other styles.
It is important to remember that table captions go ABOVE the table, while figure and diagram captions go BELOW the figure/diagram, e.g.

**Table 1: Depiction of % of dead brain cells after completing a PhD**

<table>
<thead>
<tr>
<th>Dead %</th>
<th>Live %</th>
</tr>
</thead>
<tbody>
<tr>
<td>95</td>
<td>5</td>
</tr>
</tbody>
</table>

Also, text in tables and figures can be smaller than the main text – Arial size 10, single line spaced, with 3pt ‘After’ is a good size (clarify this with your supervisor).

**Styles for special text, eg block quotes/transcript text**

If you are using long quotes from other sources (eg authors), it is standard practice to ‘lock’ these, depending on the number of words. This may vary with different disciplines, but as a rule, anything above 40 words (approx. 4 lines of text) should be block quoted. Setting a style for this makes it quick to ensure consistency throughout your text. Block quotes are generally single-line spaced and one size smaller than normal font.

**Block quotes**

1. Click on ‘Styles’
   a. scroll up ‘Styles’ until you see ‘block text’, then right click on this
   b. click ‘modify style’

2. Click on ‘Format’, select ‘Font’
   a. under ‘Font’ select ‘Arial’
   b. under ‘Font style’ select ‘Regular’
   c. under ‘Size’ select 11
   d. under ‘Font color’ select automatic
   e. all other steps same as for setting other styles
   f. click ‘OK’. This takes you back to the ‘Modify Style’ menu

3. Click on ‘Format’, then ‘Paragraph’
   a. select ‘Indents and Spacing’
   b. under ‘Alignment’, select ‘Left’
   c. under ‘Indentation’, select 1.27cm (0.5”) for both left and right
   d. check ‘automatically adjust right indent when defined’
   e. under ‘Spacing’ select 6 for ‘Before’ and 12 for ‘After’
   f. under ‘Line spacing’ select ‘single’
   g. under ‘Special’ select ‘(none)’
   h. make sure ‘Don’t add space between paragraphs of the same kind’ is NOT CHECKED
   i. check ‘snap to grid when defined’
   j. ‘Outline level’ -- no need to do anything with this
   k. Now click on the ‘Line and page breaks’ tab
   l. Under ‘Pagination’, ensure no boxes are checked, except no hyphenation
   m. Click

4. Follow all other steps as for setting ‘Normal’ style
5. Make sure that ‘Add to quick style list’ and ‘New documents based on this template’ are checked in main ‘Modify style’ menu
6. Click ‘OK’
7. Make sure you write the details of your block quote’ style with your other style details

**Transcripts**

Select your ‘block quote’ style from the quick styles menu. Follow steps for modifying the style but in the modify menu give the style a different name such as block text transcript to avoid confusion. The only changes you then need to make to set your ‘transcript’ style are:
under ‘Font’ under ‘Font style’ select ‘Italics’
b. under ‘Paragraph’, under ‘Spacing’ select 6 for ‘Before’ and 6 for ‘After’

***Handy hint: a quick way of applying designated styles to unformatted text is to use the ‘format painter’. This is the paintbrush symbol on the home menu next to the copy and paste symbols. To use the format painter, highlight text that carries the style you want then double click the paintbrush. Paint it over all the text you want to change. To turn it off, click the symbol once.

TABLES OF CONTENTS

The final step after you have got your whole thesis ready to go is to put in the Table of contents and lists of tables, figures and diagrams. This is where you realise the value of setting up styles.

1. On the main menu, click ‘References’
2. Click on Table of contents arrow on left hand side
3. This will give you choices of automatically formatted tables of contents
4. If you want to create your own style table of contents, click on ‘Insert table of contents’
   a. check ‘Show page numbers’
   b. check ‘Right align page numbers’
   c. next to ‘Tab leader’, choose a style, or ‘none’
   d. next to the ‘Formats’ box, select ‘From template’ or ‘formal’
   e. in ‘Show levels’, select 3 or 4
   f. make sure there is NO TICK in the use hyperlinks instead of page numbers box
   g. click on ‘Options’
   h. under ‘Build table of contents from’, check ‘Styles’; make sure ‘Outline levels’ is selected
   i. under ‘TOC level’, type 1 in the box next to your Heading 1 style, type 2 in the box next to Heading 2, type 3 in the box next to Heading 3, and type 4 in the box next to Heading 4.
   j. scroll through the list of styles to make sure there are no numbers next to any styles other than your 4 headings
   k. click ‘OK’. This takes you back to the first Table of contents menu
   l. click ‘OK’ again

Your table of contents will appear where you have placed the cursor before going to the insert menu. This will be at the beginning of your document.
Inserting a Table of figures

1. Make sure you place the cursor two returns down from the bottom of the end of your inserted Table of Contents
2. In References menu, look in the Captions sub-menu and click on ‘Insert table of figures’ (use this option for inserting Lists of Tables also)

Repeat steps 4.a-d as for Table of contents, then:
   e. next to 'Caption label' select 'Figure' or 'Table' or whatever caption is applicable
   f. check the ‘Include label and number’ box
   g. make sure there is NO TICK IN THE USE HYPERLINKS INSTEAD OF PAGE NUMBERS box
   h. click on ‘Options’
   i. check the ‘Style’ box, then select ‘caption’
   j. click ‘OK’. This takes you back to the first Table of Figures menu
   k. click ‘OK’ again

You may get a message asking if you want to replace the current Table of contents. Click ‘No’.

***If you are submitting your thesis electronically, you can choose the option ‘Use hyperlinks instead of page numbers’ in the web preview section of the main menu page for tables of contents, figures etc.

Check that the Tables of contents, figures etc. are correct by clicking on the page numbers (hold down control button while clicking on the number). This is also a good way to do a final check that your sequence of page numbers is correct and headings are correct (no spelling mistakes, odd spacing etc.). Your thesis is ready for printing and binding.

NOW THAT YOU HAVE SET YOUR STYLES, SAVE THE DOCUMENT AS A TEMPLATE. THIS IS VITALLY IMPORTANT.

1. Click the File Tab then click Save As. Select ‘Templates’ then in ‘Save as type’ dropdown list select ‘Word Template’, name the template ‘thesis template’ and save (see next page).
2. To open another file using the template, click on the File Tab, click on ‘New’, select ‘My templates’. Then click on your thesis template. Then click OK. This will enable you to use the same styles template for each chapter (see next page).
SECURE YOUR THESIS DOCUMENTS

If you don’t want content reviewers to accidentally modify a file, you can make formatting and editing restrictions. One option is making the file a read-only file, which can be read or copied, but not modified. If someone attempts to make changes to a read-only file, the changes can be saved only by giving the file a new name.

2. In the sidebar you can apply Formatting or Editing restrictions.
3. Editing restrictions is the most common.
4. Choose from the dropdown options Start Enforcement.

**Note:** If you forget the password you cannot get the file open or changed. Use a password you remember.

---

USE CONSISTENT LANGUAGE AND SPELLING STYLES

Check with your supervisor what type of language is to be used – Australian English, UK English or US English (or other)? Once clarified, you will need to ensure your spellings are correct for that particular type of English. You have already set the language in your styles. Now you will also need to tell the ‘Spelling and grammar checker’ what you want it to check:

1. on the main menu, select ‘Review’
2. click on ‘Spelling and grammar’
3. select ‘options’
4. select ‘Proofing’: tick the spelling and grammar options you want the computer to check for you.

If working on different computers, beware ‘default’ spelling and grammar checking dictionary languages – most default to US English. Always check by repeating the steps above when you are using a different computer.

Keep a list in a notebook of common inconsistencies, e.g. s or z, l or ll (organisation/organization; traveled/travelled). Also words that tend to be used in the wrong way, e.g. ‘affect’ and ‘effect’, and punctuation problems such as the use of apostrophes – where do you need them and where don’t you need them? If you are not sure, ask for HELP.

**WARNING:** Do not become a slave to the spelling and grammar checker, as sometimes it queries things that are correct and misses things that are incorrect. Use it as a guide only for you to check things it highlights.
REFERENCING

Reference correctly and thoroughly at all times. Incomplete or incorrect referencing can result in wasting huge amounts of time backtracking during the final phase – when you are most stressed!

Take note of the preferred in-text referencing style for your discipline – is it Harvard (author date), a footnote system, or a numbered reference list system?

Note the designated referencing style for the list of references or bibliography. Commonly used styles are Harvard, Chicago, Vancouver and Cambridge. Comprehensive referencing style guides are provided in the AGPS (Australian Government Publishing Service) guide, APA (American Psychological Association) guide and Chicago Style Manual. Some Schools within the University also publish their own preferred referencing style guide for their students. Make sure you ask if your School has one.

Many are available online.

Using Endnote is a quick way of ensuring consistency in referencing – DO THE ENDNOTE COURSES.

***Make sure you have a copy of the designated referencing guide with you at all times.***

IN-TEXT CITATION

The two most commonly used methods of in-text citation are author-date and numbered (footnote) systems:

1. **author-date:** “Tom is a great scholar” (Jones 2003, p. 45), or Jones (2003, p. 45) stated that “Tom is a great scholar”. Another way of doing this is “Tom is a great scholar” (Jones 2003: 45) or Jones (2003: 45) stated that “Tom is a great scholar”.

Two authors: Jones and Smith (2004, p. 1) agree that “Tom is a great scholar”, but “Tom is a great scholar” (Jones & Smith 2004, p. 1). ***Note you use ‘and’ outside the brackets, and ‘&’ inside the brackets.

Harvard: If there are more than three authors, use only the first named author et al. throughout, e.g. Jones et al. (2004, p. 235), unless there are two or more publications by the same first named author and others in the same year. In this case, put all of their names, e.g. Jones, Smith, Black, Brown and Green (2004, p. 235) stated that..., or “Tom is a great scholar” (Jones, Smith, Black, Brown & Green 2004, p. 235).

Vancouver: If there are up to six authors, use all the names. For more than six authors, use the first named author et al. throughout, unless there are two or more publications by the same first named author and others in the same year. In that case, use as many as are necessary to make a distinction, e.g. Jones, Smith, Black, Brown, Green and White (2004), but Jones, Smith, White, Red, Black, Yellow and Green (2004) would be Jones, Smith, White et al. (2004). Where the same author/s has more than one publication in the same year, designate one a and one b, i.e. Jones (2003a) and Jones (2003b), or Jones et al. (2004a) and Jones et al. (2004b), as long as the ‘et al.’ refers to exactly the same list of authors in the same order.

2. **Numeric referencing/footnote system:** Jones stated that “Tom is a great scholar”.1 The numbered references can appear at the bottom of each page as footnotes, or only in the reference list at the end of the document. How?

a. place cursor after the reference (and after any punctuation marks)
b. on main menu, click ‘References’
c. in Footnotes sub-menu, click arrow on right hand side
d. select ‘start at’ no. 1
e. click ‘insert’

***To insert the reference at the end of a section or the end of the document, check the ‘Endnote’ box instead of the ‘footnote box’, select ‘place at’ end of document or end of section (whichever is appropriate), then follow same steps as for formatting and insertion of footnotes.

Ensure you enter the references into the footnotes/endnotes according to the Vancouver style guide, e.g. Smith AR. The best book in town. Adelaide: Jones & Sons; 2001. (book reference)

The Chicago style also uses footnotes for in-text citations, but unlike the Vancouver style, it has a different format for some of its footnotes than it has for the bibliography, e.g. (book reference):


**BIBLIOGRAPHY/REFERENCE LIST STYLES EXAMPLES**

Book references and electronic references – a comparison of the different styles. All authors should be listed in full in the bibliography/reference lists.

**Harvard style (author-date)**


**APA style (author-date)**


**Vancouver style (footnote/endnote)**

Book: Jackson DW. Have you read my thesis?: The best one in the world. Adelaide, SA: Jackson Publishers; 1998.


**Chicago style (footnote/endnote)**


(***None of the above are actual publications – just examples of the ‘styles’).

These illustrate how important punctuation is in different referencing styles. It can all get very confusing. The main thing to remember is ‘be consistent’ and make it easier for yourself - refer to your style guides (‘cheat sheets’). Keep them with you all the time. AND USE ENDNOTE – IT IS MAGIC.

The reference list/bibliography should be arranged in alphabetical order. Where an author has several publications, enter these in ascending date order, i.e. the oldest first (1987, then 1991, then 2003 etc.). ENDNOTE will do this for you – so use it.

**USING ENDNOTE TO CREATE REFERENCE LIBRARIES**

If you are using Endnote, you must ensure that you enter all reference details correctly, and when importing citations directly from electronic libraries, do a quick check to make sure they have worked properly.

WARNING: Do not think that Endnote will somehow magically put in the references for you correctly if you have not entered them correctly. All necessary information must be added, it must be correct and it must be entered into the relevant ‘fields’.

If you are away from your computer when you find useful references, write them down in full in your thesis notebook, then enter them into Endnote as soon as possible. Wherever possible, enter references directly into Endnote.

If you are not using Endnote currently or use it but do not really understand it, please enrol in an ENDNOTE WORKSHOP – it will make your life so much easier!
HELPFUL RESOURCES

Select resources that are most relevant to your study discipline or the guidelines you have been given for producing your thesis – THERE ARE MANY AVAILABLE ON LINE and in the library.

TIPS

1. **Follow instructions** – set up documents according to these given guidelines (layout, referencing style, word count etc.)

2. **Carry pens, pencils, a ‘thesis notebook’ and disks or memory sticks** for backing up your work everywhere you go

3. **Take time to do things properly as you go along** – there may not be time to fix them at the end

4. Do not put all your faith in computers - **write down everything in the notebook** – document set-up, styles, all references, thoughts, discussion notes around references

5. **Enter all references carefully and correctly into an endnote library** – make sure you have a back-up

6. Make sure ‘same as previous’ is **NEVER** on in headers or footers

7. **Keep relevant style guides with you at all times**

8. **Seek help** when you need it – don’t let queries hang around

9. **Be consistent** with everything – styles, language, spelling, layout, in-text citations and bibliographic citations.

10. **Be wary** of ‘of’ (passive voice) and apostrophes.